Thermal Label Printer
(JD-668BT)

User Manual



Thanks for choosing us!

Customer Support

Please kindly contact us if you have
any trouble or question when installing and using

support@jadens.com

@ support.jadens.com

() 1-833-470-2950

Available Time:
Tue/Wed/Thu: EST 10AM-10PM
Fri/Sat/Sun/Mon: EST 10AM-4PM , 5PM-10PM

How can we help you today?

(Enter your questions here Q )
\

Scan the below QR code to talk with us

Customer Support

Scan or upload this QR code
using the WhatsApp camera
toadd us




Warranty Information

1-YEAR LIMITED WARRANTY - REGISTER AND ACTIVATE AT PHONE APPLICATION “Jadens Printer”.

This 1-year limited warranty applies to repair or replacement if product, at JADENS's option, is found
to be defective in material or workmanship.

All warranty requests must be accompanied by proof of purchase. When contacting us for warranty,
please have the information below.

Model:

Date of purchase:

Purchased from:

Order Number:

1. This warranty only applies to hardware components of the product that are not subject to accident,
misuse, neglect, fire or damage from other external causes, alteration, repair or commercial use. Defects
that are the result of normal wear and tear will not be considered manufacturing defects under this
warranty.

2. This warranty does not cover damage resulting from any unauthorized attempts to repair or from any
use not in accordance with the instruction manual.

3. This warranty applies only to the original purchaser of this product from the original date of purchase.
This warranty applies only if the unit is purchased new from an authorized retailer and is non-transferable
from the original purchaser of the item. Any warranties accompanied with this product is only valid in the
country of purchase.

4. Please read the Instruction Manual carefully before setting up or using this product. If you believe this
product to be suffering from a manufacturing fault, or if you have inquiries about this product, please
contact Customer Support:

ATTN: Customer Support
Email: support@jadens.com
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Print via smartphone APP

Connect adaptor Print labels
and power on
‘ ‘

Adjust paper guide

; Download APP
and insert paper

on smart phone



Print via computer
Connect adaptor
and power on
Adjust paper guide .
and insert paper Print labels
Option 1

“lllll’

Add extensions
on chrome book
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Connect USB
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Install the driver for Win
or Mac via USB cable

Option 3
Install the driver for Remove USB

Win via Bluetooth cable



1.Appearance

Power button/Feed button

Upper cover

Paper cutter

Print head

USB port

Release button Power port

Rubber roller

’ How to use the Power Button:

1. Power on/off: Press and hold 3 seconds till the green light on to turn on/till the
light off to turn off.

2. Pause printing: During the printing process, short press the power button 1 time
to pause printing. Then, if starting a new printing task, please restart the printer
and APP.

3. Feed paper: When the printer is idle, short press the power button 1 time to print
a blank page.

4. Automatic paper learning: When the printer is idle, short press the power button
2 times, the paper will be calibrated.

5. Print self-test page: When the printer is idle, short press the power button 3 times
to print the self-test page.

1 See FAQ at support.jadens.com




2. LED indicator

= O Machine status indicator

|
Bluetooth status indicator

Bluetooth Status Indicator

* Blue light on: Bluetooth connected.
« Blue light off: Bluetooth disconnected.
+ Bluetooth Module Malfunction (Bluetooth Error): Blue light flashes quickly (on 0.2s, off 0.2s).

* The blue light turns on for a few seconds and then goes off: the Windows computer is sending
a print job via Bluetooth.

Machine Status Indicator

« Normal Operation: Green light is steady.

« Cover Not Closed: Red light flashes slowly (on 1s, off 1s).
« Out of Paper: Red light flashes quickly (on 0.2s, off 0.2s).
+ Overheating: Orange light flashes slowly (on 1s, off 1s).

+ Print Paused: Green light flashes slowly (on 1s, off 1s).

3.What's in the box

APP Guide Card

APP Guide Card User Manual

USB-A to USB-C USB-C to USB-C
Power Adapter Cable Cable
for WIN for MAC

’ If any accessories are missing, please contact us for support.

2 See FAQ at support.jadens.com




4.The suitable label size

Jadens printer works with any Direct Thermal Label, and compatible with a

width range from 1"to 4.4" and length over 0.79"

p
Common thermal label sizes

O
O

2x2" 2.25x1.25" 3x5" 3x2" 4x6"

4x2"

5.Printer Connection

’ Note:

B Use only the original power adapter to avoid harm or injury.

B Unplugif notin use for a long time.

9 Connect the printer and computer @ Long press 3 seconds till the green
light on to turn on printer

See FAQ at support.jadens.com




6.How to feed label

1

O
0
m
Z

Press the release button to open the top cover fLi(t)?ﬁet Cﬁ!ﬁﬁ %lfa;adpaeij ust the paper guide to

The label you peel off should be facing up
(toward the ceiling)

© -

Carefully close the cover Label will be automatically positioned at the
tear-off point.

Printer is ready to print.

Tips:

Anytime you change your label, run the Eeed button
automatic label identification: short press
the power button 2 times, the paper will
be calibrated.

4 See FAQ at support.jadens.com



7.Smartphone APP Printing

APP download: Search for [Jadens Printer] on Google Play or App Store and download the app

for free. Please refer to the “APP Printing Quick Start Guide” for specific operating
instructions.

Download on the ' Download on the
.App Store Google Play
APP Store is a trademark of Apple Inc., registered in the U.S. and other countries.
Google Play and Google Play logo are trademarks of Google LLC.

8.Installation for Windows
’ Note:

It is recommended to close security software before installation to prevent any issues,
and you can reopen it after the installation is complete.

u Win 7 or later \/

Step1: Install the driver

Option1:Install the driver via USB cable

1. Connect the power cable and turn on the printer (Please skip this step if you have already done it).
2. Connect the USB cable to your computer (Please skip this step if you have already done it).
3. Download the driver:

Download the driver (JADENS_Printer_Driver.exe) from https://jadens.com/pages/download-video.
Driver version may be updated. See the latest info at support.jadens.com

JADENS _Printer_Driv
er_3.0.2.470_new

4. Install the driver:
Copy the printer driver to your computer desktop, double click to open and install it as below:

5 See FAQ at support.jadens.com




Printer Driver Wiza 3.0.2.466 5 & Printer Driver Wiza 3

Specify Port

Tip: If the USB option cannot be installed, please try installing with a custom optio!

B

|Vuse

network

~install printer driver

Upgrading printer drivers Bluetooth Dongle ﬁ

| Delete printer driver Bluetaoth (wireless) *l)
Parallel port
Serial port

custom

Previous step N tep

Printer Driver Wiza 3.0.2.466

Printer Driver Wiza 3.0.2.466

Specify printer model Specify printer name
model port Driver installation status
~ JD-668BT USB064 Not installed Enter the printer name

Printer Name: | JD-668BT

~ Use this printer as the default printer

cancel

Printer Driver Wiza 3.0.2.466 Printer Driver Wiza 3.0.2.466

Installing printer Installing printer

16:30:32.308 : Successfully installed printer driver:JD-668BT.
16:30:32.345 : Set as default printer.
bd 16:30:32.345 : Installation completed.

5. Print test page:
After successfully installing the printer driver, please click “print test page” to ensure the printer is

working correctly.

Note:
If you can't print successfully, please restart your computer and printer, then install driver again.

Repeat installation will create duplicate copies of the printer in your operating system such as
“JD-668BT(copy 1, 2...)"

6 See FAQ at support.jadens.com




Option2: Install the driver via Bluetooth

1. Connect the power cable and turn on the printer (It is not necessary to connect USB cable).

2. Download the driver:

Download the driver (JADENS_Printer_Driver.exe) from https://jadens.com/pages/download-
video. Driver version may be updated. See the latest info at support.jadens.com

JADENS_Printer_Driv
er_3.0.2.470 _new

3. Install the driver:

Copy the printer driver to your computer desktop, double click to open and install it as below:

Printer Driver Wiza 3.0.2.466

Printer Driver Wiza 3.0.2.466

~install printer driver
Upgrading printer drivers

| Delete printer driver

Next step cancel

Specify Port
Tip: If the USB option cannot be installed, please try installing with a custom optio|
UsB
network
Bluetooth Dangle ﬁ
" Bluetooth (wireless! )
Parallel port
Serial port

custom

Printer Driver Wiza 3.0.2.466

Printer Driver Wiza 3.0.2.466

Select Bluetooth printer .

Bluetooth Name MAC
i JD-668BT 982D

Previous stepll  Next step cancel

i 1D-6688T

Select printer driver

Q

model

PD-A4
PD-A4Pro
BY-C10
JD-568P
JD-116
JD-126

1D-24 -

The search process will take about 40 seconds. Please kindly wait.

See FAQ at support.jadens.com




Printer Driver Wiza 3.0.2.466

Specify printer name

Enter the printer name
Printer Name: | JD-668BT_Bluetooth

+ Use this printer as the default printer

Previous step cancel

Printer Driver Wiza 3.0.2.466

Installing printer

Printer Driver Wiza 3.0.2.466

Installing printer

16:36:08.021 : Bluetooth pairing successful.

16:36:12.759 : Successfully installed printer driverJD-668BT.
16:36:12.815 : Successfully added printer)D-668BT_Bluetooth.
16:36:12.847 : Set as default printer.

16:36:12.847 : Installation completed.

close

4. Print test page:

After successfully installing the printer driver, please click “print test page” to ensure the printer is

working correctly.

’ Note:

If you can't print successfully, please restart your computer and printer, then install driver again.
Repeat installation will create duplicate copies of the printer in your operating system such as

“JD-668BT(copy 1, 2...)"

See FAQ at support.jadens.com




Step2: Printer preference setting

Gotothe “Setting” > click “Device” > click “Printer & scanners” > find the printer “JD-668BT”"
> click “Manage” > click “Printer Preference” . In this part, you can set the print page size and

print speed and density of the label.

1.Setting the paper quality

a.Goto “Page Setup” .Assording to the label size, choose the corresponding page size. Generally,

most shipping labels are 4"*6"size.

%% JD-668BT_Bluetooth

1% JD-668BT_Bluetooth

K X
Stock  Parameters Grapha Crop Edge Water Mark About Stock Parameters Grapha Crop Edge Water Mark About
Paper Effects
Default Paper 4. 007x6. 00" (101. 6x152. 4)
3.257x7. 38" (82. 6x187. 5) Speed |Default = Density  Default
4. 00"x11. 007 (101. 6x279. 4) |
4.00"x13. 0(}'[10[,6.’{330. 2) |
4. 007x2. 007 (101. 6x50. 8)
4.007x2. 507 (101. 5 -
Stock |4. 00"x3. 007 (101. 6x7 Direction
4. 00754, 007 (101, 6.
Method 1. 0 [ R 52. 4) ~ o~ s
4. 00" x6. 50° (101. 6x165. 1) {« 1] )90 L) 180 270
4. 007x8. 007 (101, 6x203. 2)
Paper Type |ix6
S0mm x 30mm
Gap 50me x 40mm Offset
60om x 40mm
Gap offset —}jx t ;%m Horizontal 0 L] Vertical 0 mm |
79mm x 135mm [
BEST (T4mm x 106mm)
Media Handing ﬂ“L\'ngm_n x B0mm) Print Effect
DAY (04
e GHTE (49mm x 50mm) IS Mirrar [N iv 5 100 =
Post=Print  Jpcoym'x 180mm) (I Mirror [JNegative Scale - |
LAZADA-AG (100mm x 150mm) |
. LAZADA-AT (7T4mm x 112mm)
Appest SENDO(100mm x 150mm) |
SHOPEE-AG (100mm x 150mm) Custom Parameters |
Feed SHOPEE-AT (T4mm x 112mm)
TIKI(100mm x 150mm) = -
IVIETTEL POS'I"[Timmx 112%mm) __JAuto Dotted .P.'uus? Key |_|Water Mark
Number of JE}E-*’F
| WaiE il
€ € A

b.Inthe “Parameters” ,you can change the printing speed and printing darkness.

Especially for density, if the labels print out light or not clear, you can change the density.
For Windows system please set the density at 8-12.

For Mac system please set the density at 8-12.

See FAQ at support.jadens.com




English
2.Print a sample file.

a. Open a PDF file with Adobe, click “print” , ensure you choose the right printer (JD-668BT).
(If you want to print word file, please transfer it to PDF file to get the best quality.)

Print X

Printer: “ Properties Advanced Help @
Copies: [‘ = [ Print in grayscale (black and white) [ Save inkitoner (@)
Pages to Print SGiedlsl G
Oal Current Pages [l 85 x 11 Inches
» More Options A0S s T0F1
DO Sart! S agw B DWEALS
A WCITSZ)
Page Sizing & Handling (1) SH'?;L%H;O
Size Poster Multiple Booklet BRENTWOOD NY 00000-0000
OFit () Actual size

(O shrink oversized pages () Custom Scale: 100 %

[} choose paper source by PDF page size

TRACKING #: 00 000 000 00 0000 0000

NOER VR

Orientation: I Hmm
() Auto © Portrait () Landscape LLALE | Il
Comments & Forms Beberesce a1 Ovder oMY = =N
Document and Markups “  Summarize Comments

< >

Page 1 of 1

Page Setup... Print Cancel

b.You can goto “Properties” .In this dashboard, you can set the page size, printing speed, and
printing density as well.

¢. Preview and check the setting you want, such as print size, print density. Then click “print” .

P Note:

Before printing, please make sure the size of thermal labels you load, and the size
settings on devices are same.

1 O See FAQ at support.jadens.com




9.Installation for Mac
’ Note:

It is recommended to close security software before installation to prevent any issues,

and you can reopen it after the installation is complete.

B MacOS V109 or later -/

Step1: Install the driver

Install the driver via USB cable (MacBooks do not currently support installing drivers

via Bluetooth)

1. Connect the power cable and turn on the printer (Please skip this step if you have already done it).

2. Connect the USB cable to your computer (Please skip this step if you have already done it).

3. Download the driver:

Download the driver (JADENS_Printer_Driver.pkg) from https://jadens.com/pages/download-video.

Driver version may be updated. See the latest info at support.jadens.com

Jadens-Printer-Driver
3.0.2.470.pkg

4. Install the driver:

Copy the printer driver to your computer desktop, double click to open and install it as below:

5.Click “OK” and open “System Preferences” , and click on “Security & Privacy” . (If you don't see the

warning, you can skip this step)

i1 System Preferences

@ i
L | g Apple D, Media & App Store
® N
|

W =m a0 Q

“LabelPrinterPlus Printer

& General Desktop & Dock & Mission Siri Spotlight
Dnver_pkg" cannot be opened Screen Saver  Menu Bar Control
because it is from an unidentified @ = : @ 1
developer. ¢ — £ _
Internat Passwords Wallet & Users & Accessibility Screen Time
. . ) Accounts Apple Pay Groups
macOS cannot verify that this app is free
from malware. ’
e & 8 » o
b, i SHEEE
Software Natwark Bluetooth Sound Touch ID Keyboard
Update
Displ. Printers & Battery Date & Time Sharing Time

Scanners Machine

l

Apple ID

a

Language Motifications

& Region

L

Exi

Trackpad

w
og [f:!

& Focus

©

Security
& Privacy

Mouse

11

See FAQ at support.jadens.com




6.Clickon “Open Anyway” button. Clickon “open” and continue to install the printer.

[ ] < it Security & Privacy Q

General  FileVault = Firewall  Privacy

A login password has been set for this user  Change Password...

Require password 1 minute a after sleep or screen saver begins

[ g = : — macOS cannot verify the
; R developer of “LabelPrinterPlus
Printer Driver.pkg". Are you sure
you want to open it?

|

i By opening this app, you will be

I Allow apps downloaded from: overriding system security which can

| 1 expose your computer and personal
information to malware that may harm

| “LabelPrint...Driver.pkg” was blocked from use because it is not from ‘ your Mac or compromise your privacy_
| an identified developer. |

" Open Cancel
& Click the lock to make changes. ?

| 4

7. Follow the installation steps until you see “The installation was successful” window.

[ W] & Install Iprt Printer Driver Installer

The installation was completed successfully.

@ Introduction
Destination Select

@ Installation Type
Installation

® Summary

The installation was successful.

The software was installed.

1 2 See FAQ at support.jadens.com




8.0pen “System Preferences” > click “Printer and Scanners” .

<
e < > i System Preferences [ Q |search ]
Apple ID
General Desktop & Dock & Mission Siri Spotlight Language Notifications
Screen Saver Menu Bar Control & Region & Focus
F 7 =
8 § = |
@ - £ S
Internet Passwords Wallet & Users & Accessibility Screen Time Extensions Security
Accounts Apple Pay Groups & Privacy
! ™ h = —
® @ ¢ o = -
Software Network Bluetooth Sound Touch ID Keyboard Trackpad Mouse
Update
- i = G m o E
1417 e
Displays Printers & Battery Date & Time Sharing Time Startup
Scanners Machine Disk
d
9.Click “+” toadd a new printer.
r -
®0 < > i Printers & Scanners Q, Search
No printers are available.
Click Add (+) to set up a printer.
L+)-|
Click here to add a printer, fax or scanner  Default printer:  Last Printer Used
Default paper size: US Letter e
-

1 3 See FAQ at support.jadens.com




10. Click “JADENS JD-668BT" .

Add Printer

B ® ©

Name ~  Kind

JADENS JD-668BT USB

Name:

Location:

Use:

L%

11.Click “Add” , now the printer has been installed in your MacBook successfully.

K | Add Printer

B ® @

Q. Search
Name ~  Kind
|| JADENS JD-668BT USB |

Name: JADENS JD-668BT

Location: jadens MacBook Air

Use: LabelPrinterPlus JD-668BT

1 4 See FAQ at support.jadens.com




JADENS JD-668BT
JADENS JD-668BT

. © Idle, Last Used Open Print Queue...

Options & Supplies...

1l

jadens MacBook Air
JD-668BT
Idle

Share this printer on the network Sharing Preferences...

Default printer:  Last Printer Used

<> <>

Default paper size: US Letter

’ Note:

Now you can print directly, If you can’t print successfully, please restart your computer
and install driver again.

Step2: Printer preference setting

In this step, we will show you how to set the print preference helping you print out well.

1. Open a sample PDF file, click print.

Home  Tools 4inch by 6inch labe... * @

v I\l 1 o/ 125% v e é

1%5)5EléSC?lNSUMER CIR 48 LBS 10F 2

CORONA CA 92880 DWT: 20,16,16

SHIP TO:
K QZON COM SERVICES, INC.
24300 NANDINAAVE

MORENO VALLEY CA 92551-9534

1 5 See FAQ at support.jadens.com




2.Click “page setup” , you can select the page size you want to print.

P Note:

Before printing, please make sure the size of thermal labels you load, and the size settings on
devices are same.

Print |
Printer: JADENS JD-668BT & Advanced Help (@) |
[
Copies: 1 = Print in grayscale (black and white) [
|
[
Pages to Print Scale: 98% [
O Al Current Pages 398 x 5.8 Inches
» More Options
I i — e TorY 1
Wﬂib COM ERACES
Page Sizing & Handling (i) WC:;ESMB‘ '
| Size Poster Multiple Booklet 1
t fl
O Fit Actual size 3
Shrink oversized pages Custom Scale: % CA 19;‘93“"’ ssne 1
winea: [
Choose paper source by PDF page size |‘|I||||II|| I ||”I
Orientation: . |
] I .3
Auto © Portrait Landscape mnas swnsse -
< > 1
Comments & Forms
Page 10of 1

Document and Markups & Summarize Comments

Page Setup... Printer... Cancel Print {

Page Setup

<O

Format For: [ Any Printer

. v Any Printer
Paper Size:

Grientation: JADENS JD-668BT

Scale: Printers & Scanners Preferences...

7 Cancel OK

1 6 See FAQ at support.jadens.com




94mm x 150mm 3.69 by 5.90 inches
94mm x 187mm 3.69 by 7.36 inches

Printer: JADENS JD-668 94mm x 190mm 3.69 by 7.47 inches Help @)
'\ 94mm x 200mm 3.69 by 7.86 inches
Copies: 94mm x 210mm 3.69 by 8.26 inches
i 100mm x 100mm 3.93 by 3.93 inches !
Pagesto  Format For;  100mm x 113mm 3.93 by 4.44 inches ] %
A 100mm x 145mm 3.93 by 5.71 inches | Bx59Inches
B B LR | 100mm x 150mm 3.93 by 5.90 inches . e
| Orientation; 100mm x 180mm 3.93 by 7.08 inches B =
Page Siz Scale, 100MmM X 190mm 3.93 by 7.47 inches T
: ' " 100mm x 200mm 2.92 by 7.86 inches
| 100mm x 210mm 3.93 by 8.26 inches s CA9119-03
D ? 105mm x 145mm 4.12 by 5.71 inches ' |||||||||||||
Shring 105mm x 150mm 4.12 by 5.90 inches Lo -
Chousém 105mm x 187mm 4.12 by 7.36 inches M“l |II|| I|I|”I
105mm x 190mm 4.12 by 7.47 inches n
| Orientation: 105mm x 200mm 4.12 by 7.86 inches e —
Auto: (=] Portrait 105mm x 210mm 4.12 by 8.26 inches = ;
194mm x 87mm 7.62 by 3.42 inches - ’
Comments & Forms
Document and Markups | Manage Custom Sizes... Page 10f 1
Page Setup... Printer... Cancel Print |

If there is no suitable size to choose “Manage custom sizes” , input the width and height, then click
/Iokll .

3.Click “printer preference” > Choose “printer feature” >setup “Darkness” and “Print Speed” .

Print
| Printer: JADENS JD-668BT B Advanced Help @
Copies: 1 2 Print in grayscale (black and white)
Pages to Print Scale: 98%
O Al Current Page: 3.93 5.9 Inches _
» More Options
| i T 7
Page Sizing & Handli ™ e
a zin n [
= o Stk ) mwwm '
| T
I Size Poster Multiple Booklet |
| I
O Fit Actual size >
Shrink oversized pages Custom Scale: % CANEBI;-C‘:_!_““ e
Choose paper source by PDF page size |‘II|||II‘| I Iml
Orientation:
|
Auto © Portrait Landscape .
< =
Comments & Forms
- Page 1 of 1
Document and Markups = Summarize Comments

Page Setup... s m

1 7 See FAQ at support.jadens.com




Print

Printer: = JADENS JD-668BT

Presets: Default Settings

<>

Copies: 1

Pages: © All

From: 1 to: 1

( Layout )

Layout
Paper Handling

Cover Page
o5 | [

Border: None

Two-Sided: O >

Reverse page orientation
Flip horizontally

?  PDF Hide Details Cancel

Print
Printe el ®
J Printer: JADENS JD-668BT
Copit
Presets: Default Settings a
Page|
- Nﬂ Copies: 1 S
> M —
Pages: © All rorx | .
From: 1 o 1
Page i
Printer Features | - |
o F
: [ Feature Sets:  Printer Settings .
Ch Media Tracking: Gap
Method: Use Currently Printer Setting B
Orie
“:J Darkness: Default &) B-| ]
Print Speed: Default =
com5 4 ]
Doc

page .7 | PDF Hide Details Cancel (m Print )

1 8 See FAQ at support.jadens.com




10.How to Use a label Printer with a “Chromebook”

Scan the QR code below to view the guide video.

Scannen Sie den QR-Code unten, um das Anleitungsvideo anzuzeigen.
Scannez le code QR ci-dessous pour regarder la vid é o du guide.
Escanee el c6 digo QR a continuaci 6 n para ver el videogu i a.
HAFETFZRBICIE TOQROI—FZRF v LTLEW

(DConnect the printer with your Chromebook with provided USB wire, and turn on
the printer.

_—
(2)Search “Shipping Printer” on Chrome Web Store: https://chromewebstore.google.com/

» O 2 chromewebstore.google.com

& chrome web store Discover Extensions  Themes Q, Shipping Printer X

a Todoist for Chrome
- Tockay Organize work and life with Todoist for Chrome
todoist -

— 4.7 % TOOK
for Chrome — - 51,053 reviews | Users
-

Top categories

1 9 See FAQ at support.jadens.com




(3Download “Shipping Printer” extension to your Chrome.

G %5 chromewebstore.google.com/detail/shipping-printer/pbnnbmkdimmpdadgafibd.

imphcin %

~— chrome web store Discover Extensions Themes Q, Search extensions and themes

. Shipping Printer

1.4 % (9 ratings)

Extension Workflow & Planning 5,000 users

"" a If) .

Print from select file

C @ Fie -2eSeabT2edib3l 17860/ MyFiles/Dy i i 1).paf < W EEI

Extensions

No sccess needed

These extensions don neod to see and change
TATENS 3 th his 5

., 38 1BS TOF; infarmation on this site

CORDNA CA 52880 OWT: 20,1618

&  Application Launcher For Drive.

SHIEIR, vy o

ON.COM SERVICES, INC.

24300 NANDINAAVE . oo
MORENO

VALLEY CA 92551-9534

& Manige extensions

ae| CA9119-03

<] INENRR T

TRACKING#: 1Z81R WB3 03 7358 6843

2 O See FAQ at support.jadens.com




(3)Click “connection” con.

@ cmh A L p—— -

x |+ ¥ o F X

©  ® Shipping Printer | chrome-extersicn omencphdotciicibignihoinmepidd mome b < % w0

Shipping Printer

@ This extension not work in Windows system now. we suggest you use our windows client. please
chick this link 10 download it

Printer

@ ! you sent print data from ancther tab, after you click Print bution, you must return this page If
you dont do this. will not trigger printing

Print from select file

(6)Choose your printer to connect.

@ crosh X | @ dinchby 8inch label sample{1)p X @ Shipping Printer x +

C (% Shipping Printer) chrome-extension:/fomencphfofckbfojbjgnihofnmepiidd/home.html

*Shipping Printer” wants to connect

Printer-Paired

Shipping P

<in Windows system now. we suggest you use our window
adit.

>m another tab, after you click Print button, you must returr
ot trigger printing.

®@ Cancel

O— <ttt point y coordinate

0 0 @) Label paper [ )

48 LBS 10F2

TABTNL
EEH CoMSUNLE O
COROA Ca IS0 AT 281616

SHIRJ%DN COM SERVICES, INC.
IDINAAVE

MORENO VALLEY CA 92551-9534

CA9119-03

9119-03

TRACKINGS: 1Z81R WRI O3 7358 6843
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(®Click "More settings" to select the paper size and copies as you need, then click "Print".

Print 1 sheet of paper
1525 CONSUMER CIR 481BS 10F2
COROMNA CA 92880 DWT: 20,16,16
Destination & Shipping Printer -
SHIKVJQZON COM SERVlCES INC.
24300 NANDINA Pages all
MORENO ALLEY CA92551-9534
Coples 1

| CA9119-03 @ | More settings R

|||‘|| |" |‘|||‘ ‘|| | || ‘| || ||| Paper size 150_4.00 * 6.00 inch

Pages per sheat 1

CA9119—0

TRACKING#: 1Z81R W83 03 7358 6843

Scale Default
Options [ Print as image

(BILLING: PP @
==
HOLZ0A3 0L W4T JR.0A 1L/3030° Cancel

(9)Turn back to the " Shipping label " extension setting page.
The printer will then print the label.

@ cmh ® | @ dinch by binchishel mavpie(1) . X @

© % Shigping Prirter | chrome-extensionfomencphiofckbiofbigrih

= % »0
Shipping Printer

o This extension not work in Windows system now. we suggest you use our windows client. please
click this link {o download it .

Printer

@ 1 you sent print data from another tab, after you click Print button, you must return this page.If
you don't do this. will not trigger printing,

- IS

After clicking the "Print" button,
please go back to the settings page.

The printer will then print the label.

Print from select file

200 "B®OOC

11. Important Tips: Print label of multiple size
using " Take a snap shot "

The function of " Take a snap shot " can solve most print problem. It enables you to print the area you
want. Now let us show you how to use it.

1.How to print your labels with nonstandard size.

If the printed PDF/file is unusual size such as A4 which can't be found the same size label. In this
situations, you have to use the function of " take a snapshot " to print. Here are the steps to operate.
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b. From the top panel, select Edit > Take a Snapshot. choose the area you want to print.

(1).For windows:

a. Open the PDF in Adobe Reader
b. From the top panel, select " Edit "' > " Take a Snapshot " . choose the area you want to print.

IEXY view Sign Window Help

'D Undo
C’ Redo
Cut
Ez copy
Paste

Delete

Select All
Deselect All

Delete Pages
O Rotate Pages

Copy File to Clipboard

Edit Text & Images

Ctrl+Z Sign Window Help

Shift+Ctrl+Z pols

al - Copy.pdf - Adobe Acrobat Reader DC (64-bit)

Label-original - Co... x

- O

® A

Sig

Ctrl+X
Ctrl+C

Ctrl+V

Ctrl+A
Shift+Ctrl+A

| :ﬁ Take a Snapshot

Check Spelling

Q find

Look Up Selected Word...

Ctrl+F

c.Click “Print” , set up the page size same as the labels you load, then print.

’ Note:

Please make sure the page size match to the loaded label size. Otherwise, it is possible that
it prints out over label or misaligned.

Print

Printer:| JD-668BT

| properies | ncvancea

Help @

o

Pages to Print
(@) All Cuy
* More Options

Page Sizing & Han
L= |
@) Fit

() Shrink oversized §
[} Choose paper sof

Orientation:

(O Auto (®) P

Comments & Forms
Document and Marl

Page Setup... .

# JD-668BT Properties
Stock Parameters Grapha Crop Edge Water Mark About

Paper

Default Paper |100mm*150mm

3. 257 x7. 38" (82. 6x187. 5)
4.00"x11. 00 (101. 6x279. 4)
“x13. 007 (101. 6x330. 2)
2. 007 (101, 6x50. 8)

. 507 (101. 6x63. 5)

2
3.
4. 00" (101. 6x101. 6
6.

“x
"x

X
" x

Method 4. 50_(101. 6x165. 1

50 B 5
8. 007 (101, 62203, 2)

'
F )

4

4

4

4

Stock 4.
4

4

Paper Type ;

Gap

79mm x 135mm

BEST (76mm x 106mm)
(CHN(80mm x E0mm)

CUSTOM

GHTK (49mm x 50mm)
JT(74mm x 180mm)
LAZADA-AG (100mm x 150mm)
LAZADA-AT (75em x 112mm)
SENDO (100mm x 150mm)
Number of copie|SHOPEE-AG(100mm x 150mm)
SHOPEE-AT (75mm x 112mm)
TIKI(100mm x 150mm)
VIETTEL POST(75mm x 112mm)

Media Handing

Post-Print

Appear

ink/ftoner @

23
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(2)For MAC

a.Find the “File” in the top left corner of you desktop > Click “Open” >Click “Desktop” >Choose PDF
file (or you can open the file with Adobe)

Share File

Close

Propartias...

Print....

b. From the top panel, select “View” > “Rotate View” > “Clockwise” so that the labels are side by side.
(If the labels has laid vertically. Please skip this step)

®  Acrobat Reader File Edit o
FEN) Rotate View . 135396-2021-04-01(3).pd
Page Mavigation L&
Home Tools item-m772 | -
208 Dieckay = .f}lCmmarclockwin o%n- |
® B EQ | o PR MO ® s - B-P B g
Tools L
Show/Hide >
Display Theme 13
’ Read Mode BRI ... .. c.cc st M e o S T o g s
- Full Screen Mode 3L i
7 B
‘5 Tracker...
HT Read Out Loud »
b ! ‘I'E a‘ — £ — i
L O = D | — g
5 § S— o | — 2
M~ = — &
5 — 0 — 3
ik L == 1A C | — 2 2 "
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12.Frequently asked question

Go to support.jadens.comto see FAQ
How can we help you today?

‘ Enter your search term here...

13.Pro tips

- Anytime you change label size, run the automatic label identification by pressing and holding
the feed button until you hear one short beep.

- Press the feed button on the printer to skip a blank label.

-To run a self-test, short press the power button 3 times to print the self-test page.
- Avoid using poor quality labels as they can damage the printer.

- Regularly clean the printer head as described in 18. MAINTENANCE.

- If paper is jammed, turn off the printer, and allow the printer head to cool down. Open the cover
and ensure that the rubber is clean. If dirty, use alcohol pad to clean. Allow the area to dry off
before turning the printer on.

p O

&

14.Driverremovement

For windows:
Open the driver again and follow below steps to uninstall thedriver.

Printer Driver Wizard 3.0.1.211 20220719151653 @ X Printer Driver Wizard 3.0.1.211 20220719151653
Remove Printer
Q
Printer
Install the printer driver ‘ Microsoft Print to PDF
B JD-668BT
R inter dri
| HP Color Laser)et Pro MFP M176n
| Fax

For Mac:

Click “System Preferences” > “Printer & Scanners” , click “JADENS JD-668BT” > “.”
> “Delete Pinter” .
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Are you sure you want to delete
the printer “JADENS JD-668BT"?

Cancel [ Delete Printer J

15.Specifications

Printing Method Thermal

Resolution 203DPI

Max Printing Speed 100mm/s

Label Width 1"-4.4"(25.4-112mm)

Label Thickness

0.08-0.2mm

Connection USB + Bluetooth
Input Voltage 100-240V

Power Adapter 24V /1.5A
Supported Paper Direct Thermal Labels

Supported Operating Systems

Bluetooth Connection:

i0S, iPadOs, Android, Windows 7
or later

USB Connection:

MacOs V10.9 or later, ChromeOs,
Windows 7 or later

Printing Life

4"x6": ~328,000 labels
2"x1": ~1,968,000 labels

Label Minimum Length

26
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16.Safety tips

- Anytime you change your label, run the automatic label identification: short press the power
button 2 times, the paper will be calibrated.

- Do not bend the power cord excessively or place objects on the cord.
This could result in fire.

- Keep the printer out of reach of children.

- Use only approved accessories and do not try to disassemble or repair the unit by yourself.

- Keep the printer away from water and other objects that may destroy or damage the device.
- Printer should remain unplugged when not in use for long periods of time.

17.Maintenance

CLEANING THE PRINT HEAD

The printer head is a sensitive part of the printer and can be found on the upper part of the printer
when open.

Caution: While the printer is running, the printer head can be very hot.

1. Ensure that the power switch is OFF, remove the power cord, and open the cover. Wait several
moments to ensure that the printerhead cools down.

2. Completely clean the printer head using an alcohol swab. Any 70% Isopropyl Alcohol pad would
work. Please do not use water.

3. Wait 2-3 minutes until the alcohol has completely dried, then close the cover.
4. Connect the power cord and print a test page to check if it is clean.
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18.Trouble shooting

Indicator light

Status

Trouble shooting

Green light is steady

The printer is normal

Green light flashes
slowly (on 1s, off 1s)

Print paused

Press the feed button
once to resume the
current printing process.

Red light flashes
quickly (on 0.2s, off
0.2s)

Paper error lack of paper

Make sure there is no
paper adhesion or paper
jam. Note®@

Make sure the printer
loads the paper correctly.

Note®W®@

Perform automatic
intelligent label learning.

Red light flashes
slowly (on 1s, off 1s)

Cover not closed

Check that top coveris
closed completely

Orange light flashes
slowly (on 1s, off 1s)

Print head is overheating

Wait for the printer to
cool down, and it will
continue working
automatically. Note @

Blue light on Bluetooth connected
Blue light off Bluetooth disconnected
Note:

(D These faults can be resolved without shutting down the
printer. After troubleshooting, the printer can continue to
operate automatically without losing any print content.

(2 Check the faults in sequence. If a previous fault cannot be
resolved, proceed to the next step.

28
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FCC Caution:

Any Changes or modifications not expressly approved by the party responsible
for compliance could void the user's authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.

IMPORTANT NOTE:

Note: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

—Reorient or relocate the receiving antenna.
—Increase the separation between the equipment and receiver.

—Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

—Consult the dealer or an experienced radio/TV technician for help.

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. This equipment should be installed and operated with
minimum distance 20cm between the radiator& your body.
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ISED Warning

This device complies with Inovation, Science, and Economic Development
Canada licence-exempt RSS standard(s). Operation is subject to the following
two conditions:

(1) this device may not cause interference, and

(2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Le présent appareil est conforme aux CNR d' Imnovation, Sciences et
Développement économique Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes:

(1)l'appareil nedoit pas produire de brouillage, et

(2)l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi,
méme si le brouillage est susceptible d'en compromettre le fonctionnement.

The device is compliance with RF exposure guidelines, users can obtain Canadian

information on RF exposure and compliance.The minimum distance from body

to use the device is 20cm.

Le présent appareil est conforme Aprés examen de ce matériel aux conformité
ou aux limites d'intensité de champ RF, les utilisateurs peuvent sur l'exposition

aux radiofréquences et la conformité and compliance d'acquérir les informations
correspondantes. La distance minimale du corps a utiliser le dispositif est de 20cm.
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Can we help?
For further assistance please contact

JADENS

support@jadens.com

@ support.jadens.com

() 1-833-470-2950
Available Time:

Tue/Wed/Thu: EST 10AM-10PM
Fri/Sat/Sun/Mon: EST 10AM-4PM , 5PM-10PM

Scan the below QR code to talk with us

= Customer Support

Scan or upload this QR code
using the Wh atsApp camera
to add us
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